
 PREFACE

SEPTODONT HOLDING (“SEPTODONT“) recognize the importance of protecting the
privacy of all customers (“you” or “user”) who visit the SEPTODONT hosted or
sponsored local website.

We also believe it is important to inform you about how we will use your personal
data, and to give you choices about how this data will be used. For these reasons, we
encourage you to read this Privacy Policy carefully.

This Privacy Policy is directed and applicable to individuals who visit those portions of
the SEPTODONT local websites accessible at www.septodontcorp.com, as well as
and including any other SEPTODONT site or web pages accessible through such site
or other promotional websites SEPTODONT hosts or sponsors such pages on third
party social networking services, directed at French, Spanish or English speaking
customers in countries where there is no localized version of the SEPTODONT website
accessible by going to the “Languages” page or link in the home page of
www.septodont.com (collectively the “Sites”).

This Privacy Policy applies only to information collected by us via the Sites. SpeciLc
privacy policies may apply in other countries or world regions where a local version of
the Site exists.

You expressly acknowledge and agree that your personal data may be collected on
the Sites.

1.GENERAL INFORMATION

This Privacy Policy sets forth how SEPTODONT collects and uses your personal data
and the measures taken to ensure the protection of your personal data while you use
the Site, pursuant to French law.

SEPTODONT protects the privacy of the users of its Sites by complying with the
applicable regulations in force. Accordingly, SEPTODONT, as data controller, has
notiLed the French data protection authority (Commission Nationale de l’Informatique
et des Libertés) (“CNIL“) that it collects and processes your personal data.

2. DATA COLLECTION, DATA USE AND DATA STORAGE

 

http://www.septodontcorp.com/privacy-policy/#


a) Data Collection

a1) IdentiDable Personal Data

SEPTODONT is likely to collect directly your IdentiLable Personal Data, namely via, the
data collection form, “Contact” section.

“IdentiLable Personal Data” refers to information related to you as an individual,
communicated by you by using the contact form, or that SEPTODONT collects within
the framework of your use of the Sites and which, whatever their nature constitutes
direct or indirect IdentiLable Personal Data. IdentiLable Personal Data includes
personal data (such as your Lrst and last name, contact information such as email,
and phone, as provided by you) as well as electronic identiLcation data available on or
from your computer (such as cookies or IP addresses). Your electronic identiLcation
data makes it possible to identify and geolocalize your internet connection device and
the pages you visited while using the Sites. As such, electronic identiLcation data
generally cannot be used to identify you personally.

In order to Lght against counterfeiting and infringement, SEPTODONT has set up
automated processes to collect information on companies or individuals who commit
or are likely to commit acts that violate its rights. This information will be accessible to
any company legally authorized to use the SEPTODONT trademarks, in France or
abroad, that has been a victim of such violations, for the purpose of taking action or
any necessary measures to protect their rights.

a2) Cookies

Cookies cannot be used to identify you. However, they record information relating to
your computer’s use of the Sites (the pages you visit, the date and time of your visit,
etc.), which SEPTODONT may use during subsequent visits, or the number of times
SEPTODONT promotional content is displayed on third-party sites or applications.

SEPTODONT may collect information by installing a cookie or web beacon on your
computer via the Sites. SEPTODONT may also memorize connection and login
preferences and information relating to use of online services. Depending on the
settings you choose for your device, which you can change at any time, the cookies
that SEPTODONT installs via the Sites do the following:



Determine statistics and volumes relating to traVc and use of the Sites’ various
components (sections and content visited, and paths used), which help improve
the relevance and user-friendliness of the services offered to you; and
Count clicks for components of online services.

SEPTODONT may also purchase advertising space to promote its products using
promotional content distributed via third-party sites or applications, which may
contain cookies. Depending on the settings you choose for your device, which you can
change at any time, such cookies may be installed on your device in order to:

Count the number of displays and activations of our promotional content
distributed via third-party sites or applications; identify such content and sites or
applications; and determine the number of users that have clicked on each
content display; and
Establish statistics.

If you do not wish SEPTODONT to use all or part of the above mentioned cookies
please click here. Please be aware that restricting cookies may impact on your user
experience and may prevent you from using part of our website.

SEPTODONT hereby informs you that you can also disable the installation of cookies
by conLguring your browser as follows:

For Mozilla Firefox: Select the “Tools” menu, then “Options”. Click the “Privacy”
icon, locate the “Cookies” menu and select your preferred options.
For Microsoft Internet Explorer: Select the “Tools” menu, then “Internet Options”.
Click the “ConLdentiality” tab and use the cursor to select the level desired.
For Opera: From the “File” menu, select “Preferences”, then click on “Privacy” and
select your preferred options.
For Safari: From the Safari menu, select “Preferences”, then click on “Security”
and select your preferred options.
For Google Chrome: select the Chrome menu, then select “Settings” and click on
“show advanced settings”. In the Privacy section chose “Content settings” ; then
In the “Cookies” section you can select your options.

a3) Social networks

SEPTODONT publishes pages on social networks such as Facebook™ that present

http://www.septodontcorp.com/cookies-policy/


and provides information on SEPTODONT on such social networks.

You can follow SEPTODONT’s pages on those social networks. Personal information
that you have designated as public and that is accessible from your proLle can be
accessed by SEPTODONT. SEPTODONT does not create or use any databases
unaVliated with those social networks that would be compiled from any personal
data you publish there.

If you wish to block SEPTODONT from accessing the personal data that you have
published on your proLle (and which is publicly visible), we remind you that social
networks allow you to restrict access to your information. We recommend that you
check their IdentiLable Personal Data policy on a regular basis.

 b) Data Use

The information you provide on the Site enables SEPTODONT to:

Process your questions and requests for information;
Assess the Sites’ audience;
Send you the News you have subscribed for;
Provide information on SEPTODONT products;
Inform you of events organized by SEPTODONT;
Invite you to take part in surveys;
Enable you to follow the Sites and its latest developments (in the SEPTODONT
News section).

Mandatory information required by SEPTODONT to carry out the above tasks is
marked with an asterisk on the different pages of the Sites. All other information is
optional. It helps us to know you better and to improve our communication and the
services we offer you.

c) Data Storage

SEPTODONT may store your IdentiLable Personal Data for a period of up to three
years following the last date of contact. Cookies used to analyze traVc on the Sites
are stored for thirteen months.

3. SHARING AND DISCLOSURE OF PERSONAL DATA



The data collected shall be provided only to SEPTODONT and to companies
authorized to use the SEPTODONT trademarks.

SEPTODONT will not transmit your IdentiLable Personal Data to third parties unless:

SEPTODONT is required to share such information with its distributors or service
providers, in particular, its technical service providers, to supply a service that you
have requested (for example, sending a Newsletter); or

SEPTODONT receives a request from a judicial authority or any other legally
authorized administrative authority asking that such information be disclosed in
compliance with the laws in force.

SEPTODONT will use its best efforts to ensure the conLdentiality and security of
IdentiLable Personal Data that has been collected when transmitting it to the
aforementioned entities.

When you introduce a SEPTODONT brand product to someone you know using the
“share” function provided on the Site, the information you enter is used only to send
your message. It is not stored by SEPTODONT or used for any other purpose. You are
solely responsible for any messages you send to people you know using the “share”
function.

4. DATA TRANSMITTED BY SITE USER OTHER THAN REQUESTED BY SEPTODONT

SEPTODONT requests that you refrain from transmitting any content including but not
limited to business, advertising, creative, marketing or any other types of proposals,
concepts, know-how, ideas and the like (“Unsolicited Materials”) that is not requested
via a questionnaire or any other collection form, such as commercial information,
advertisements, personal creations, ideas, or concepts, Etc.

All Unsolicited Materials, including any unsolicited Personal Information (for example,
Personal Information provided not in response to a speciLc request for such
information, but in a free form text box), that we receive will not be subject to this
Privacy Policy. By submitting any Unsolicited Materials, you agree that we shall have
the sole discretion as to how to utilize such Unsolicited Materials and you
automatically provide to us a perpetual, royalty free license to such end. If any
Unsolicited Materials that you provide to us are protected by third party copyright,



trademark or other proprietary rights, you agree to indemnify, defend, and hold
harmless SEPTODONT against any claims or actions brought against SEPTODONT
arising out of or relating to our use or possession of the Unsolicited Materials.

5. SECURITY

SEPTODONT will use its best efforts to protect your IdentiLable Personal Data against
damage, loss, disclosure, misappropriation, intrusion, alteration, and destruction.

SEPTODONT’s information systems are protected by state-of-the-art hardware and
software security systems. Physical and electronic safeguard procedures are
implemented in connection with data collected on the Site, in accordance with the
applicable French laws governing personal data protection.

Any SEPTODONT employees who, in the course of their work, might have access to
your IdentiLable Personal Data agree to hold it in the strictest conLdence.

However, SEPTODONT has no control over the risks in connection with the functioning
of the internet and draws your attention to the existence of potential risks in terms of
conLdentiality of the data transiting via this network. Access to information proposed
on the Sites might be interrupted for high priority events or beyond SEPTODONT’s
reasonable control, or reasons which do not fall under SEPTODONT’s scope of
responsibility.

6. INDIVUDAL RIGHTS RELATING TO DATA COLLECTION

a) Right to Access, Modify, Correct, and Delete Data

You have a general right to access, modify, correct, and delete data that concerns you.

To exercise your right please send your request to our Customer Service Department
by Llling out the “Contact Us” form.

To process your request, please send us the following information required for
identiLcation purposes: your Lrst and last name, your email address, and possibly your
mailing address.

b) Unsubscribing



SEPTODONT’s newsletters offers users a free Newsletter service, which you are free
to subscribe.

Users of the Site who no longer wish to receive it can unsubscribe as follows:

by simply clicking on the unsubscribe link located at the bottom of each
Newsletter; or
by Llling out the “Contact Us” form and specifying your request and the email
address to be unsubscribed in your message.

7. USE OF DATA IN THE EVENT OF A CHANGE OF CORPORATE CONTROL

Data collected by SEPTODONT may be transferred to third parties within the
framework of a change of corporate control, an acquisition, bankruptcy proceedings,
or the sale of company assets.

8. PRIVACY POLICY AND MINOR

The Site is not targeted towards minors. However, access to the Site is not reserved
for healthcare professionals, as it does not present any content prohibited for minors
under the age of 18.

The Site forms and questionnaires are not aimed at collecting information on minors.
If information on a minor has been collected by the Site, the minor’s legal
representative can contact SEPTODONT’s Customer Service Department to correct,
modify, or delete the information (see section 6. a))

9. PRIVACY POLICY UPDATE

The Privacy Policy may be modiLed by SEPTODONT at any time. Should SEPTODONT
wish to use your personal data other than as stipulated in the IdentiLable Personal
Data Policy in force at the time of data collection, notice of any such modiLcations will
be posted on the Sites in a visible manner and you will also receive notice by email if
you have subscribed to the Newsletter.

With regard to any changes which may be made to the IdentiLable Personal Data
Policy, we invite you to check the “IdentiLable Personal Data” section on a regular
basis.



10. QUESTION AND CONTACT

For any question or comment relating to the IdentiLable Personal Data Policy or the
manner in which SEPTODONT collects and uses your IdentiLable Personal Data,
please contact us at dataprotection@septodont.com.

Updated on: April 2018 – Copyright © SEPTODONT HOLDING

mailto:dataprotection@septodont.com

